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B u i l d i n g  a  s i m p l e  s y s t e m  i n  W o r k i n g  

M o d e l

This tutorial will take you through the easy 
process of building a simple system, and 
simulating its behavior.  The tutorial will 
also give you an overview of Working 
Model and its basic features.

What is Working Model? 

Knowledge Revolution Working Model™ 
combines advanced motion simulation 
technology with sophisticated editing capabilities 
to provide a complete, professional tool for 
engineering and animation simulation.  The  
dynamic simulation engine provides a translation 
of real world Newtonian mechanics to the 
computer, while the simple but powerful 
graphical user interface makes it easy to 
experiment with different scenarios and 
situations.   

Simulation Engine

The simulation engine of Working Model™ is designed for both speed 
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and accuracy.  It calculates the motion of interacting bodies using 
advanced numerical analysis techniques.  The engine allows the 
construction of complex systems, and computes their motion under a 
variety of constraints and forces.  In addition to user-imposed 
constraints such as springs, pulleys, or joints, the engine has the 
capability to deal with world-level interactions, such as collisions, 
gravity, wind-resistance, and electrostatics.  The engine is fully 
configurable, and every aspect of a simulation from the time step (fixed 
or variable) to the integration technique can be specified by the user.   

Smart Editor™

The Smart Editor™ is the core of the user interface, keeping track of 
connections and constraints among objects as they are constructed.  To 
develop a mechanism, a user simply starts to draw the components on 
the screen and indicates where and how the pieces should be joined.   
The Smart Editor™ allows the mechanism to be rotated and dragged, 
while maintaining the fundamental integrity of the components and of 
the joints between them.  Users can position objects by using the 
standard click-and-drag Macintosh paradigm, or by specifying their 
coordinates precisely in dialog boxes.  In all cases, the Smart Editor™ 
makes sure that no link is broken and no mass is stretched.  A robot arm, 
composed of many parts held together by pivot joints, can be positioned 
accurately using the Smart Editor™.   By clicking and dragging the 
hand, the arm stretches out to the desired conformation.

FPU support

Working Model is designed to take full advantage of the  Floating Point 
Unit (floating-point math coprocessor), if one is available.  This speeds 
the computations enormously, allowing for faster, smoother animation.  
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If no such unit is available, Working Model™ defaults to standard 
Macintosh arithmetic.

Inter-Application 
Communication

Working Model uses Apple events to communicate with other 
applications during a simulation.  Users can specify physical models of 
real-life mechanical designs and then control them externally through 
other programs.  For instance, a Microsoft Excel™ worksheet can be 
used to model an external control system.  Data can be passed to a 
spreadsheet, results can be calculated, and then the answer can be 
returned to Working Model, all while a simulation is in progress.

Complex functions, such as table lookup, can be implemented in a 
spreadsheet and then linked to a Working Model simulation.

Export of Static and Animated 
Data

Working Model imports and exports data to most popular CAD 
programs through the DXF file format.  Also supported are the standard 
PICT, Meter Data, and QuickTime movie formats. 

Animated data can be exported in a variety of formats.  Because of the 
accuracy with which it models complex interactions of moving objects, 
Working Model is a natural tool for creating animated images of 
unprecedented realism.  The frame sequences themselves can be 
exported in a variety of standard file formats, including MacroMind 
Three-D, Wavefront, and DXF animation, allowing a seamless 
integration of Working Model files with animation programs.

Input and Output Devices  

Real-time input devices include sliders, buttons, and text fields.   

Real-time output devices include graphs, digital displays, and bar 
displays.
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Complete set of FastAction™ 
Buttons  

You can create a button to execute Working Model menu commands, 
including Run, Reset, and Quit.  Buttons can simplify pre-made 
simulations for the first-time user.  With buttons, you can create 
Working Model documents that are similar to HyperCard stacks in that 
one document can lead to the next by the click of a button.

Moving Graphics  

You can paste pictures created with a paint or draw program directly on 
the workspace, as well as link them to objects.  For example, you can 
create a circular mass object and attach a picture of a baseball to it.

Custom Global Forces  

You can now simulate planetary gravity as well as earth gravity, 
electrostatic forces, and air resistance proportional to velocity or 
velocity squared, or create your own custom global forces by supplying 
an equation.  For example, you can create magnetic fields, wind, and 
electron gun fields.

Text tool  

You can annotate experiments directly on the workspace, using any font, 
size, or style of text.

Extensive Graphical Features

You can show and hide objects, fill objects with patterns and colors, 
display how objects are charged (+ or -), choose the thickness of an 
object’s outline, show object names, display vectors in various ways and 
colors.

Multiple Reference Frames

You can now create different views using any mass or point as the frame 
of reference.  
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Complete Control of Units

Choose from standard metric units such as kilograms, meters, and 
radians; standard English units such as foot, inch, yard, second, degrees, 
pounds; or other kinds of units such as light-years for measuring 
distance. 

Complete Scripting Language

Working Model has a scripting language for creating formulas that is 
very similar to the formula language used in Excel and Lotus 1-2-3.   

Equations

Any value can be a formula rather than a number.  For example, you can 
create a formula for a mass object that simulates a rocket, or create a 
formula for a force that simulates a sinusoidal driver.

No-Menu Player Documents

Player mode provides an experiment window with a limited menu bar 
and no palette, giving more room to display the experiment.  Player 
mode documents can be used by people who are not familiar with 
Working Model.

Custom Tracking

You can track all objects or limit tracking to selected objects.  Individual 
objects can leave tracks of their outline, center of mass, or vectors.  You 
can also connect tracks with lines.

Object Layering

The experiment world consists of two layers:  one for user objects such 
as meters, and one for physical objects such as masses and constraints.  
Full control of which objects collide is provided.

An Almost Infinite World

The experiment world can be as large as you like (up to ±1.0e4900 
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meters).  Zoom is infinite within the bounds of the world.

Vector Displays  

Working Model comes with a complete set of vector displays for 
showing velocity, acceleration, and force.  Vectors can be displayed for 
electrostatic forces, for planetary forces, and at multiple contact points 
when two objects collide.

Save Time History

You can calculate and record complicated or time-consuming 
simulations overnight and play them back in real time.  You can then 
save the entire experiment, to disk.

Group Center of Mass Object  

You can show the center of mass of all objects.  This feature is useful as 
a frame of reference for the center of mass in different views.

Pause Control  

Stop or pause experiments automatically.  For example, you can set the 
experiment to pause when two seconds have elapsed by entering the 
following formula:  Pause when time > 0.2.  You can also tell your 
experiments to loop and reset.

Apply Control

You can apply forces and constraints at different times.  For example, 
you can apply a constant force on an object for one second, or you can 
apply a force when the object’s velocity is greater than 10.

Unlimited Objects

You can create as many objects and constraints as your computer’s 
memory allows.  



7

Starting Working Model

1. Double-click the Working Model Demo icon to start the 
program.

Working Model starts up and opens a new, untitled window.  Your screen 
will look like Figure 1.

Figure 1
Untitled  Working Model window

Toolbar

Help Ribbon

Tape Controls

The new, untitled experiment document appears in its own window.  You will 
see the toolbar on the left and the tape controls along the bottom of the window.

Figure 2
The toolbar
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The toolbar contains tools you will use to create experiments.  Tools are 
provided for creating masses, springs, ropes, forces, and many other objects.  
The toolbar also contains buttons for running and resetting experiments.

The tape controls give you more control for running and viewing experiments.  
You can use the tape controls to step through experiments, play experiments 
backwards, or move to a specific time in an experiment.

Setting Up a Simple Experiment

In this exercise, you will draw a circle to 
represent a projectile and specify its initial 
velocity.  Then you will watch the projectile fly 
as you run the experiment

Drawing a circle 

The toolbar provides a variety of tools for setting up 
experiments.  To choose a tool, click on it.

To draw a circle (see Figure 3): 
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Figure 3
Drawing a circle

Press and hold 
down the mouse 
button here...

...drag to here 
and release the 
mouse button

Select the 
circle tool

1. Click the Circle tool.

2. Position the pointer at any starting point in the blank area of 
the screen. 

The pointer changes from an arrow to a crosshair.  This means you are 
ready to create an object.

3. Drag the mouse until the circle is the size you want, then 
release the mouse button.

A line appears inside the circle.  During an animated sequence, this line 
indicates the circle’s rotation.

Moving the circle to its starting position

To position the circle for the start of the experiment:

1. Select the Arrow tool if it isn’t already selected.

2. Position the pointer anywhere inside the circle (except for the 
center of the circle, see next section).
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3. Drag the circle to the lower left corner of the screen, as shown 

in Figure 4. 

Figure 4
Dragging the circle

Press and hold 
down the mouse 
button here...

...drag to here 
and release the 
mouse button

Specifying an initial velocity

To specify the initial velocity of the projectile: 

1. Click the circle to select it.

Four square dots appear around the circle and one round dot appears at 
its center.

2. Position the pointer on the center dot in the circle and drag 
away from it to approximate the projectile’s initial velocity (see 
Figure 5). 

While dragging, try to match the arrow shown in Figure 5.

3. Release the mouse button at the desired initial velocity.

An arrow representing the projectile’s initial velocity appears. 
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Figure 5
Specifying an initial velocity for the 
projectile

Position the 
pointer on the 
dot...

...drag to here 
and release the 
mouse button

4. Drag the tip of the arrow to adjust the velocity.

Running the experiment

You are now ready to run your experiment.  To run the 
experiment:

1. Click Run in the toolbar.

Watch your first experiment run.  Because normal earth gravity is on by 
default in a new document, the circle flies with the motion of a typical 
projectile.

Figure 6
Run and Reset buttons
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Click here to Run

2. Click once to stop the experiment.

3. Click Reset in the toolbar to rewind the experiment.

4. Go back to step 3 under “Specifying an initial velocity” and try 
running this experiment with different velocities.

Measuring Properties from an Experiment

Working Model allows you to measure many 
physical properties such as velocity, acceleration, 
and energy by using meters and vectors.

Meters and vectors provide visual representations 
of quantities you want to measure.  Meters can 
display information as:  

• numbers (digits)

• graphs

• level indicator (bars)

Vectors represent the properties of velocity, 
acceleration, and force as visual arrows.  The 
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direction of the arrow shows the direction of the 
velocity, acceleration, or force.  The length of the 
arrow corresponds to the magnitude of the 
velocity, acceleration, or force.  

In the following exercises, you will measure a 
projectile’s velocity and display it in various 
ways.  First, you will display it as a digital meter. 
Then you will change that meter to a graph.  
Finally, you will display the velocity of the 
projectile as an animated vector. 

Displaying a velocity meter

To display a digital meter that measures the velocity of 
the projectile, follow these steps:

1. Click Reset in the toolbar.

2. Draw a circle in the lower left-hand corner of the workspace if 
you don’t already have one.  Select the circle.

Your screen should resemble Figure 7.  The circle becomes selected: four 
small dots and the velocity arrow appear.  If your screen does not resemble  
Figure 7 you can repeat the steps of the previous section.  If you already 
know how to create objects and give them initial velocities, create a single 
circular mass, and give it an initial velocity similar to that shown in Figure  
7.

Figure 7
A circular projectile with an initial 
velocity
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3. Choose Velocity from the Measure menu, and All from the 
Velocity sub menu.

A digital velocity meter appears (Figure 8).

Figure 8
A velocity meter

4. Click Run in the toolbar.

As the projectile flies, you can monitor its velocity by watching the velocity  
meter.
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5. Click on the Stop button to stop the experiment.

Displaying vectors 

To display the velocity of the projectile as an animated 
vector:

1. Select the circle.

2. Choose Vectors from the Define menu.

The Vectors sub menu appears.

3. Choose Velocity from the Vectors menu.

In the future, a check mark will appear next to Velocity in the Vectors 
menu, indicating that  velocity vectors are being displayed.

4. Click Run in the toolbar. 

When you run the experiment, a vector appears on the circle, showing its 
velocity.  

5. Click the Stop button to stop the experiment.

For more information about vectors, see “Tracking” in chapter 8, “Running 
Experiment”.

Tracking

Tracking shows the path of an object by 
recording its location at specific intervals.  

1. Click Reset in the toolbar if you have run and not yet reset the 
experiment.

2. Choose Tracking from the World menu, and then choose Every 
8 frames from the sub menu.
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When you run the experiment, Working Model will display the position of 
the circle at eight frame intervals. 

3. Click Run in the toolbar.

The projectile’s path will be traced as it flies .

4. Click Stop to stop the experiment.

Creating or editing objects erases the track.

The Smart Editor™

You will now use the Working Model Smart 
Editor to create and edit a mechanism.  When you 
drag the mechanism with the mouse, it will move 
like a real mechanism.  The Smart Editor will 
enforce constraints while you edit.  

To construct a four-bar linkage:

1. Create a new Working Model document by selecting New from 
the File menu. 

Close all open documents prior to starting this exercise.

2. Double click the rectangle tool on the toolbar.  

The tool will turn black, indicating that it can be used multiple times.

3. Sketch a rectangle similar to the one in Figure 9.

Figure 9
A single rectangle
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4. Sketch two rectangles projecting below the horizontal 
rectangle.

Make sure the rectangles overlap since you will need to join them together.  
Your screen should resemble Figure 10.

Figure 10
The beginnings of a four-bar linkage

You will now create pin joints.  A pin joint acts as a hinge between two mass 
objects.  The Smart Editor will prevent joints from breaking during a drag 
operation.
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5. Double click on the Pin Joint tool.

The tool will turn black, indicating that it can be used multiple times.

6. Sketch two pin joints by clicking once with the mouse for each 
joint.

Your screen should resemble Figure 11.

Figure 11
Pinning the mechanism together

Click here to create pin joints

Pin joints automatically connect to the top two mass objects that lie beneath 
them.  If only one mass object lies beneath a pin joint, the pin joins the mass to 
the background.

7. Select the arrow tool by clicking on the toolbar.

8. Try dragging the top rectangle.

All three rectangles should follow the motion of the mouse, because the pin  
joints connect them.  If the rectangles break apart, one of the pins did not 
join two rectangles together, but instead one rectangle to the background.  
Delete the pin, make sure the two rectangles overlap, and  re-join them.
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9. Add two new pin joints at the bottom of the two vertical 

rectangles.

Your screen should resemble Figure 12 These pins will join the rectangles 
to the background.

Figure 12
Pinning the mechanism to the 
background

Pin joints between 
the rectangles and 
the background

10. Click the arrow tool and then drag the top bar.

The joints pivot and the bars now move relative to one another.  The Smart  
Editor moves the mechanism while making sure that pin joints do not 
separate.

Figure 13
Dragging the mechanism
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Click here and drag the mechanism

Joining and Splitting

The smart editor can automatically assemble a 
mechanism.  The Split tool “splits” pin joints, leaving a 
separate point on each mass object.  These points can be 
edited individually, and then the pin joint can be re-
assembled with the Join command.

1. Restore the mechanism to its original form.

Your screen should resemble Figure 14. If you have only dragged the 
mechanism one time, you can select Undo from the Edit menu.  Otherwise, 
drag the mechanism until it is resembles its original form.

2. Select the arrow tool.

3. Click on the top left pin joint to select it.

The pin joint turns black when selected.

Figure 14
Selecting a pin joint
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Click here to select the pin joint

4. Click the Split button in the toolbar.

The pin joint is split, or temporarily broken.  You can move the left vertical  
rectangle independently.  The vertical rectangle is still attached to the 
background.  The other two rectangles are free to move as a unit.  While 
you move the rectangles around, the split pin joint is connected by a dotted  
line.

Figure 15
A split pin joint
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5. Try dragging the different mass objects.

Do not drag the pin joints.

6. Move the mass objects to a position where the pin joint is 
almost connected.

Try dragging each of the different mass objects.  Your screen should 
resemble Figure 16.

Figure 16
Preparing to join

Move until the points are almost overlapping

7. Click on the left mass object.

The Join button becomes active.  The tool is active because there is a point  
attached to the mass object, and the point can be joined to another point.

The Join button will also become active if you select either of the split 
points.

8. Click the Join tool.

The linkage will reassemble itself, moving its component pieces around to 
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make them overlap where necessary.

Figure 17
The re-joined mechanism

If the points that make up the pin joint are a long distance apart, the Smart  
Editor will ask you to move the points closer together before making the 
join.

Precision numerical assembly

The Smart Editor assembles mechanisms based on 
numerical values.  Whenever you enter the position of a 
mass object, point, or joint, the Smart Editor makes sure 
that joints are not broken.  If necessary, the smart editor 
will move other mass objects to keep the integrity of all 
joints in a mechanism.

You can use the Smart Editor to set the initial conditions 
of an experiment.  In this example, you will use the 
Smart Editor to return the mechanism to its exact initial 
position.
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1. Double-click on the rectangle that is pinned between two other 

rectangles. 

This is the rectangle that was originally horizontal.

Figure 18
Double-clicking a rectangle

Double-click this rectangle

The Properties utility window will appear.  You can also select the mass 
object and choose Properties from the Window menu to show this window.

Figure 19
Properties utility window for a mass
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Edit this field

2. Enter the value 0 in the rotation (ø) field of the Properties utility 
window.

3. Enter a Tab or Return.

The mass will be moved to a position where its rotation is 0.00.  The other 
masses in the mechanism will move to satisfy this condition.

Figure 20
Using numerical editing for 
precision alignment

This mass now has a rotation of 0.00
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The Next Step

To learn more about Working Model you can 
open the file Complex Tutorial, which will take 
you through building a more complex model.  
Alternatively you can look at some of the pre-
built demonstration models available in the 
Tutorials, Engineering and Animation folders.


